Exploring the Max Interface

Well, here we are with a new version of Max, and the first question on the minds of existing users is “Did the interface change?” The answer is a gleeful “not much.” Most serious users would rather go through root canal surgery than have their user interface (UI) change, and although Autodesk has learned and respected this valued opinion, you’ll find some minor changes.

As you look around the new interface, you’ll see that everything is still there but that Max has several clever, new additions. You may find yourself saying, as you navigate the interface, “where did that come from?” But, just like encountering a new house in your neighborhood, over time you’ll become accustomed to the addition and might even meet some new friends.

Why is the software interface so important? Well, consider this: The interface is the set of controls that enables you to access the program’s features. Without a good interface, you may never use many of the best features of the software or spend a frustrating bit of time locating it. A piece of software can have all the greatest features, but if the user can’t find or access them, then the software won’t be used to its full potential. Max is a powerful piece of software with some amazing features, and luckily the interface makes these amazing features easy to find and use.

The interface is all about making the features accessible, and in Max you have many different ways to access the same command. Some of these access methods are faster than others. This design is intentional because it gives beginning users an intuitive command and advanced users direct access. For example, to undo a command, you can choose Edit ➪ Undo (requiring two mouse clicks), but as you gain more experience, you can simply click the Undo icon on the toolbar (only one click); an expert with his hands on the keyboard will press Ctrl+Z without having to reach for the mouse at all. All three of these methods have the same result, but you can use the one that is easiest for you.

Has the Max interface succeeded? Yes, to a degree, but like most interfaces, it always has room for improvement, and we hope that each new version takes us closer to the perfect interface (but I’m still looking for the “read my thoughts” feature). Discreet has built a loophole into the program to cover anyone who complains about the interface—customization. If you don’t like the current interface, you can change it to be exactly what you want.
Customizing the Max interface is covered in Chapter 5, “Customizing the Max Interface and Setting Preferences.”

This chapter examines the latest incarnation of the Max interface and presents some tips that make the interface feel comfortable, not cumbersome.

**The Interface Elements**

If you’re new to the Max interface, the first order of business is to take a stroll around the block and meet the neighbors. The Max interface has a number of interface elements that neatly group all the similar commands together. For example, all the commands for controlling the viewports are grouped together in the Viewport Navigation Controls found in the lower-right corner of the interface.

If all the details of every interface command were covered in this chapter, it would be an awfully long chapter. So for those commands that are covered in more detail elsewhere, I include a cross-reference to the chapter where you can find more information.

The entire interface can be divided into five easy elements. Each of these interface elements, in turn, has groupings of sub-elements. The five main interface elements are listed here and shown separated in Figure 1-1:

- **Menus:** This is the default source for most commands, but also one of the most time-consuming interface elements. The menus are found along the top edge of the Max window.

- **Toolbars:** Max includes several toolbars of icon buttons that provide single-click access to features. These toolbars can float independently or can be docked to an interface edge. By default, the main toolbar and the reactor toolbar are visible.

- **Viewports:** Four separate views into the scene show the Top, Front, Left, and Perspective viewpoints.

- **Command Panel:** The major control panel located to the right of the four viewports, it has six tabbed icons at its top that you can click to open the various panels. Each panel includes rollouts containing parameters and settings. These rollouts change depending on the object and tab that is selected.

- **Lower Interface Bar:** Along the bottom edge of the interface window is a collection of miscellaneous controls.

In addition to these default elements are several additional interface elements that you will find useful. These controls aren’t initially visible when Max is first loaded, but they can be accessed by working with the interface. These additional interface elements include the following:

- **Floating toolbars:** Several additional toolbars are available as floating toolbars. You access them by choosing Customize ➪ Show UI ➪ Show Floating Toolbars or by selecting them from the toolbar's right-click pop-up menu. These floating toolbars include Axis Constraints, Layers, Extras, Render Shortcuts, Snaps, and Brush Presets.
✦ **Quadmenus**: Right-clicking on the active viewport makes a pop-up menu with up to four panes appear. This is called a quadmenu. Quadmenus offer context-sensitive commands based on the object or location being clicked and provide one of the quick ways to access commands.

✦ **Dialog boxes and editors**: Some commands open a separate window of controls. These dialog boxes may contain their own menus, toolbars, and interface elements. A good example of this element is the Material Editor, which has enough controls to keep you busy for a while.

![Image of Max interface elements](image)

**Figure 1-1**: Max includes five main interface elements.
Using the Menus

The pull-down menus at the top of the Max interface include most of the features available in Max and are a great place for beginners to start. Several of the menu commands have corresponding toolbar buttons and keyboard shortcuts. To execute a menu command, you can choose it from the menu with the mouse cursor, click its corresponding toolbar button if it has one, or press its keyboard shortcut. You can also select commands using the keyboard arrows and press the Enter key to execute them.

The main menu includes the following options: File, Edit, Tools, Group, Views, Create, Modifiers, Character, reactor, Animation, Graph Editors, Rendering, Customize, MAXScript, and Help. Unlike some other programs, these menu options do not disappear if not needed. The list is set, and they are always there when you need them.

If a keyboard command is available for a menu command, it is shown to the right of the menu item. If an ellipsis (three dots) appears after a menu item, that menu command causes a separate dialog box to open. A small black arrow to the right of a menu item indicates that a submenu for this item exists. Clicking the menu item or holding the mouse over the top of a menu item makes the submenu appear. Toggle menu options (such as Views ‹ Show Ghosting) change state every time they are selected. If a toggle menu option is enabled, a small check mark appears to its left; if disabled, no check mark appears.

A complete list of keyboard shortcuts can be found in Appendix C, “Max Keyboard Shortcuts.”

You can also navigate the menus using the keyboard by pressing the Alt key by itself. Doing so selects the File menu, and then you can use the arrow keys to move up and down and between menus. With a menu selected, you can press the keyboard letter that is underlined to select and execute a menu command. For example, pressing Alt, then F (for File) and N (for New) executes the File ‹ New command; or you can press Alt, use the down arrow to select the New command, and press the Enter key.

By learning the underlined letters in the menu, you can use the keyboard to quickly access menu commands, even if the menu command doesn't have an assigned keyboard shortcut. And because you don't need to stretch for the Y key while holding down the Ctrl key, underlined menu letters can be faster. For example, pressing Alt, G, and U successively, you can access the Group ‹ Ungroup menu command. The keyboard buffer remembers the order of the letters you type regardless of how fast they are keyed, making it possible to quickly access menu commands using the keyboard. Over time, you can learn patterns to help you remember how to access certain menu commands, such as Alt, C, H, E for creating an ellipse.

Not all menu commands are available at all times. If a menu command is unavailable, then it is grayed out, as shown in Figure 1-2, and you cannot select it. For example, the Clone command is available only when an object is selected, so if no objects are selected, the Clone command is grayed out and unavailable. After you select an object, this command becomes available.
Using the Toolbars

Now that you've learned the menu two-step, it is time for the toolbar one-step. The main toolbar appears by default directly under the menus at the top of the Max window, and the reactor toolbar appears docked to the left edge of the interface. Using toolbars is one of the most convenient ways to execute commands because most commands require only a single click.

You can make any docked toolbar a floating toolbar by clicking and dragging the two vertical lines on the left (or top) end of the toolbar away from the interface edge. After you separate it from the window, you can resize the floating toolbar by dragging on its edges or corners. You can then drag and dock it to any of the window edges or double-click on the toolbar title bar to automatically dock the toolbar to its latest location. Figure 1-3 shows the main toolbar as a floating panel.

If you right-click on any toolbar away from the buttons, you can access a pop-up menu that includes options to Customize, show, or hide any of the toolbars or the Command Panel. You can also show or hide all floating toolbars or the main toolbar with the Customize: Show UI menu command. The main toolbar can be hidden with the Alt+6 keyboard shortcut.

Figure 1-3: The main toolbar includes buttons and drop-down lists for controlling many of the most popular Max functions.
You can customize the buttons that appear on any of the toolbars. See Chapter 5, “Customizing the Max Interface and Setting Preferences.”

All icon buttons (including those found in toolbars, the Command Panel, and other dialog boxes and windows) include tooltips, which are identifying text labels. If you hold the mouse cursor over an icon button, the tooltip label appears. This feature is useful for identifying buttons. If you can’t remember what a specific button does, hold the cursor over the top of it and the tooltip gives you its name.

All toolbar buttons with a small triangle in the lower-right corner are flyouts. A flyout is a single toolbar button that expands to reveal additional buttons. Click and hold on the flyout to reveal the additional icons, and drag to select one. Figure 1-4 shows the flyout for the Align button on the main toolbar.

Figure 1-4: Flyout menus bundle several toolbar buttons together.

The General panel of the Preference Settings dialog box contains an option for setting the number of milliseconds to wait before the flyout appears.

Toolbar buttons that open dialog boxes such as the Layer Manager, Material Editor, and Render Scene buttons are toggle buttons. When the dialog box is open, the button is highlighted yellow, indicating that the dialog box is open. Clicking on a highlighted toggle button closes the dialog box. Corresponding menus (and keyboard shortcuts) work the same way, with a small check mark appearing to the left of the menu command when a dialog box is opened.

Learning the main toolbar

On smaller resolution screens, the main toolbar is too long to be entirely visible. To see the entire main toolbar, you need to set your monitor resolution to be at least 1280 pixels wide. To scroll the toolbar to see the end, position the cursor on the toolbar away from the buttons, such as below one of the drop-down lists (the cursor changes to a hand); then click and drag the toolbar in either direction. Using the hand cursor to scroll also works in the Command Panel, Material Editor, and any other place where the panel exceeds the given space.

The easiest way to scroll the main toolbar is to drag with the middle mouse button.

Table 1-1 lists the controls found in the main toolbar. Buttons with flyouts are separated with commas.
Table 1-1: Main Toolbar Buttons

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Undo" /></td>
<td>Undo (Ctrl+Z)</td>
<td>Removes the last performed command. You can set the levels of Undo in the Preferences dialog box.</td>
</tr>
<tr>
<td><img src="image" alt="Redo" /></td>
<td>Redo (Ctrl+Y)</td>
<td>Brings back the last command that was undone.</td>
</tr>
<tr>
<td><img src="image" alt="Select and Link" /></td>
<td>Select and Link</td>
<td>Establishes links between objects.</td>
</tr>
<tr>
<td><img src="image" alt="Unlink Selection" /></td>
<td>Unlink Selection</td>
<td>Breaks links between objects.</td>
</tr>
<tr>
<td><img src="image" alt="Bind to Space Warp" /></td>
<td>Bind to Space Warp</td>
<td>Assigns objects to be modified by a warp.</td>
</tr>
<tr>
<td><img src="image" alt="Selection Filter" /></td>
<td>Selection Filter drop-down list</td>
<td>Limits the type of objects that can be selected.</td>
</tr>
<tr>
<td><img src="image" alt="Select Object" /></td>
<td>Select Object (Q)</td>
<td>Chooses an object.</td>
</tr>
<tr>
<td><img src="image" alt="Select by Name" /></td>
<td>Select by Name (H)</td>
<td>Opens a dialog box for selecting objects by name.</td>
</tr>
<tr>
<td><img src="image" alt="Selection Region" /></td>
<td>Rectangular Selection Region, Circular Selection Region, Fence Selection Region, Lasso Selection Region, Paint Selection Region (Ctrl+F to cycle)</td>
<td>Determines the shape used for selecting objects.</td>
</tr>
<tr>
<td><img src="image" alt="Window/Crossing Toggle" /></td>
<td>Window/Crossing Toggle</td>
<td>Specifies whether an object must be crossed or windowed to be selected.</td>
</tr>
<tr>
<td><img src="image" alt="Select and Move" /></td>
<td>Select and Move (W)</td>
<td>Selects an object and allows positional translations.</td>
</tr>
<tr>
<td><img src="image" alt="Select and Rotate" /></td>
<td>Select and Rotate (E)</td>
<td>Selects an object and allows rotational transforms.</td>
</tr>
<tr>
<td><img src="image" alt="Select and Uniform Scale, Select and Non-Uniform Scale, Select and Squash" /></td>
<td>Select and Uniform Scale, Select and Non-Uniform Scale, Select and Squash (R to cycle)</td>
<td>Selects an object and allows scaling transforms using different methods.</td>
</tr>
<tr>
<td><img src="image" alt="Reference Coordinate System drop-down list" /></td>
<td>Reference Coordinate System drop-down list</td>
<td>Specifies the coordinate system used for transforms.</td>
</tr>
<tr>
<td><img src="image" alt="Use Pivot Point Center, Use Selection Center, Use Transform Coordinate Center" /></td>
<td>Use Pivot Point Center, Use Selection Center, Use Transform Coordinate Center</td>
<td>Specifies the center about which rotations are completed.</td>
</tr>
</tbody>
</table>

Continued
### Table 1-1 (continued)

<table>
<thead>
<tr>
<th>Toolbar Button</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Select and Manipulate" /></td>
<td>Select and Manipulate</td>
<td>Selects an object and allows parameter manipulation via a manipulator.</td>
</tr>
<tr>
<td><img src="image" alt="Snap Toggle 2D" />, Snap Toggle 2.5D, Snap Toggle 3D (S)</td>
<td>Snap Toggle 2D, Snap Toggle 2.5D, Snap Toggle 3D (S)</td>
<td>Specifies the snap mode. 2D snaps only to the active construction grid, 2.5D snaps to the construction grid or to geometry projected from the grid, and 3D snaps to anywhere in 3D space.</td>
</tr>
<tr>
<td><img src="image" alt="Angle Snap Toggle (A)" /></td>
<td>Angle Snap Toggle (A)</td>
<td>Causes rotations to snap to specified angles.</td>
</tr>
<tr>
<td><img src="image" alt="Percent Snap (Shift+Ctrl+P)" /></td>
<td>Percent Snap (Shift+Ctrl+P)</td>
<td>Causes scaling to snap to specified percentages.</td>
</tr>
<tr>
<td><img src="image" alt="Spinner Snap Toggle" /></td>
<td>Spinner Snap Toggle</td>
<td>Determines the amount a spinner value changes with each click.</td>
</tr>
<tr>
<td><img src="image" alt="Edit Named Selection Sets" /></td>
<td>Edit Named Selection Sets</td>
<td>Opens a dialog box for creating and managing selection sets.</td>
</tr>
<tr>
<td><img src="image" alt="Named Selection Sets drop-down list" /></td>
<td>Named Selection Sets drop-down list</td>
<td>Lists and allows you to select a set of named objects.</td>
</tr>
<tr>
<td><img src="image" alt="Mirror Selected Objects" /></td>
<td>Mirror Selected Objects</td>
<td>Creates a mirrored copy of the selected object.</td>
</tr>
<tr>
<td><img src="image" alt="Align (Alt+A), Quick Align, Normal Align (Alt+N), Place Highlight (Ctrl+H), Align to Camera, Align to View" /></td>
<td>Align (Alt+A), Quick Align, Normal Align (Alt+N), Place Highlight (Ctrl+H), Align to Camera, Align to View</td>
<td>Opens the alignment dialog box for positioning objects, allows objects to be aligned by their normals, determines the location of highlights, and aligns objects to a camera or view.</td>
</tr>
<tr>
<td><img src="image" alt="Layer Manager" /></td>
<td>Layer Manager</td>
<td>Opens the Layer Manager interface where you can work with layers.</td>
</tr>
<tr>
<td><img src="image" alt="Open Curve Editor" /></td>
<td>Open Curve Editor</td>
<td>Opens the Function Curves Editor.</td>
</tr>
<tr>
<td><img src="image" alt="Open Schematic View" /></td>
<td>Open Schematic View</td>
<td>Opens the Schematic View window.</td>
</tr>
<tr>
<td><img src="image" alt="Material Editor (M)" /></td>
<td>Material Editor (M)</td>
<td>Opens the Material Editor window.</td>
</tr>
<tr>
<td><img src="image" alt="Render Scene Dialog (F10)" /></td>
<td>Render Scene Dialog (F10)</td>
<td>Opens the Render Scene dialog box for setting rendering options.</td>
</tr>
<tr>
<td><img src="image" alt="Render Type drop-down list" /></td>
<td>Render Type drop-down list</td>
<td>Selects the area or objects to render.</td>
</tr>
<tr>
<td><img src="image" alt="Quick Render (Production), Quick Render (ActiveShade)" /></td>
<td>Quick Render (Production), Quick Render (ActiveShade)</td>
<td>Produces a quick test rendering of the current viewport without opening the Render Scene dialog box.</td>
</tr>
</tbody>
</table>
Viewing the floating toolbars

If you select the Customize ➪ Show UI ➪ Show Floating Toolbars menu command, several additional toolbars appear. These are floating toolbars. You can also make them appear by selecting them from the toolbar right-click pop-up menu. The floating toolbars are Axis Constraints, Layers, reactor, Extras, Render Shortcuts, Snaps, and Brush Presets, but the reactor toolbar is docked to the left side of the interface by default.

The Brush Presets toolbar is new to 3ds Max 8.

Using the Viewports

The four viewports make up the largest area of the entire interface and provide a way of viewing the objects within the scene. Each of the viewports is configurable and can be unique from the others.

Understanding how to work with the viewports is vital to accomplishing tasks with Max, so viewports have an entire chapter dedicated just to them—Chapter 2, “Configuring the Viewports.”

Using the Command Panel

If there is one place in Max, besides the viewports, where you’ll spend all your time, it’s the Command Panel (at least until you’re comfortable enough with the quadmenus). The Command Panel is located to the right of the viewports along the right edge of the interface. This is where the object parameters, settings, and controls are located. The Command Panel is split into six panels, each accessed via a tab icon located at its top. These six tabs are Create, Modify, Hierarchy, Motion, Display, and Utilities.

You can pull away the Command Panel from the right window edge as a floating dialog box, as shown in Figure 1-5, by clicking on the open space to the right of the tabbed icons at the top of the Command Panel and dragging away from the interface edge. You can also dock it to the left window edge, which is really handy if you’re left-handed. While it’s a floating panel, you can resize the Command Panel by dragging on its edges or corners (but its width remains constant).

After you’ve pulled the Command Panel or any of the toolbars away from the interface, you can re-dock them to their last position by double-clicking on their title bar. You can also right-click on the title bar to access the pop-up menu of floating toolbars, but the pop-up menu also includes options to Dock (either Left or Right for the Command Panel or Left, Right, Top or Bottom for toolbars) and Float.
Part I  ✦ Learning the Max Interface

Figure 1-5: The Command Panel includes six separate panels accessed via tab icons.

Working with rollouts

Most of the controls, buttons, and parameters in the Command Panel are contained within sections called rollouts. A rollout is a grouping of controls positioned under a gray, boxed title, as shown in Figure 1-6. Each rollout title bar includes a plus or minus sign (a minus sign indicates that the rollout is open; a plus sign shows closed rollouts). Clicking the rollout title opens or closes the rollout. You can also reposition the order of the rollouts by dragging the rollout title and dropping it above or below the other rollouts.

Note

You cannot reposition some of the rollouts, such as the Object Type and the Name and Color rollouts found in the Create panel.

Figure 1-6: Open and close rollouts by clicking on the rollout title.
Right-clicking away from the buttons in a rollout presents a pop-up menu where you can select to close the rollout you’ve clicked in, Close All, Open All, or Reset Rollout Order. The pop-up menu also lists all available rollouts within the current panel with a check mark next to the ones that are open.

Expanding all the rollouts often exceeds the screen space allotted to the Command Panel. If the rollouts exceed the given space, then a small vertical scroll bar appears at the right edge of the Command Panel. You can drag this scroll bar to access the rollouts at the bottom of the Command Panel, or you can click away from the controls when a hand cursor appears. With the hand cursor, click and drag in either direction to scroll the Command Panel. You can also scroll the Command Panel with the scroll wheel on the mouse.

You can customize the Command Panel like the other toolbars. Customizing the Command Panel is covered in Chapter 5, “Customizing the Max Interface and Setting Preferences.”

Increasing the Command Panel’s width

The Command Panel can also be doubled or tripled (or any multiple as long as you have room) in width by dragging its left edge toward the center of the interface. The width of the Command Panel is increased at the expense of the viewports. Figure 1-7 shows the Command Panel double its normal size.

Figure 1-7: Increase the width of the Command Panel by dragging its left edge.
Tutorial: Rearranging the interface for lefties

I used to work for a company that required that all computers have the mouse to the left of the keyboard. We swapped computers often, and the boss hated having to move the mouse to the other side of the keyboard (and you thought your work environment was weird). The reality is that some people like it on the left and others prefer it on the right, and Max can accommodate both.

With the Command Panel on the right side of the interface, the default Max interface obviously favors right-handers, but with the docking panels, you can quickly change it to be friendly to lefties.

To rearrange the interface for lefties, follow these steps:

1. Click the Command Panel on the empty space to the right of the Utilities tab, and drag toward the center of the interface. As you drag the Command Panel away from the right edge, the cursor changes.

2. Continue to drag the Command Panel to the left edge, and the cursor changes again to indicate that it will be docked when released. Release the mouse button, and the Command Panel docks to the left side.

3. For an even easier method, you can right-click on the Command Panel’s title bar and select Dock ➪ Left from the pop-up menu.

4. Next, dock the reactor toolbar on the right side by dragging it from the left to the right.

Figure 1-8 shows the rearranged interface ready for all you southpaws.
Using the Lower Interface Bar Controls

The last major interface element isn’t really an interface element but just a collection of several sets of controls located along the bottom edge of the interface window. These controls cannot be pulled away from the interface like the main toolbar, but you can hide them using Expert Mode (Ctrl+X). These controls, shown in Figure 1-9, include the following from left to right:

✦ **Time Slider:** The Time Slider, located under the viewports, enables you to quickly locate a specific frame. It spans the number of frames included in the current animation. Dragging the Time Slider can move you quickly between frames.

✦ **Track Bar:** The Track Bar displays animation keys as color-coded rectangles with red for positional keys, green for rotational keys, and blue for scale keys. Parameter change keys are denoted by gray rectangles. Using the Track Bar, you can select, move, and delete keys.

✦ **Status Bar:** The Status Bar is below the Track Bar. It provides valuable information, such as the number and type of objects selected, transformation values, and grid size. It also includes the Transform Type-In fields.

✦ **Prompt Line:** The Prompt Line is text located at the bottom of the window. If you’re stuck as to what to do next, look at the Prompt Line for information on what Max expects.

✦ **Key Controls:** These controls are for creating animation keys and include two different modes — Auto Key (keyboard shortcut, N) or Set Key (keyboard shortcut, ’). Auto Key mode sets keys for any changes made to the scene objects. Set Key mode gives you more precise control and sets keys for the selected filters only when you click the Set Keys button (keyboard shortcut, K).

✦ **Time Controls:** Resembling the controls on an audio or video device, the Time Controls offer an easy way to move through the various animation frames and keys. Based on the selected mode (keys or frames), the Time Controls can move between the first, previous, next, and last frames or keys.

✦ **Viewport Navigation Controls:** In the lower-right corner of the interface are the controls for manipulating the viewports. They enable you to zoom, pan, and rotate the active viewport’s view.

![Figure 1-9: The Lower Interface Bar includes several sets of controls.](image)
Interacting with the Interface

Knowing where all the interface elements are located is only the start. Max includes several interactive features that make the interface work. Learning these features makes the difference between an interface that works for you and one that doesn’t.

Gaining quick access with the right-click quadmenus

Quadmenus are pop-up menus with up to four separate sections that surround the cursor, as shown in Figure 1-10. Right-clicking in the active viewport opens these quadmenus. The contents of the menus depend on the object selected.

Tip

Many of the real pros use quadmenus extensively. One of the reasons they do is that they can access the commands from the mouse’s current location using a couple of clicks without having to go all the way to the Command Panel to click a button.

Clicking with the left mouse button away from the quadmenu closes it. For each menu, the last menu item selected is displayed in blue. To quickly access the blue menu item again, simply click the gray-shaded bar for the quadrant that contains the blue menu item. Using Customize ➪ Customize User Interface, you can specify which commands appear on the quadmenus, but the default options have just about everything you need.

Figure 1-10: Quadmenus contain a host of commands in an easily accessible location.
Understanding the button color cues

Max’s interface uses color cues to help remind you of the current mode. When a button is yellow, it warns that it has control of the interface. For example, if one of the select buttons on the main toolbar is selected, it turns yellow and any dragging in the viewport affects the object; however, if one of the Viewport Navigation Control buttons is selected, it turns yellow and dragging the viewport changes the view. Knowing what the current mode is at all times can keep you out of trouble.

Right-clicking in the active viewport exits any mode that has control and returns control to the Select Object mode. Right-clicking in one of the inactive viewports keeps the focus where it is and makes that clicked viewport active.

Another common button color is red. When the Auto Keys or Set Keys buttons are depressed, they turn red. The edge of the active viewport being animated also turns red. This reminds you that any modifications will be saved as a key.

Toggle buttons are buttons that can be turned on and off. Example toggle buttons include the Snap buttons. When a toggle button is enabled, it also turns yellow. Toggle buttons highlighted in blue are non-exclusive, but they notify you of a mode that is enabled, such as the Key Mode Toggle or the Affect Pivot Only button.

All interface colors can be customized using the Customize User Interface dialog box that is discussed in Chapter 5, “Customizing the Max Interface and Setting Preferences.”

Using drag-and-drop features

Dialog boxes that work with files benefit greatly from Max’s drag-and-drop features. The Material Editor, Background Image, View File, and Environmental Settings dialog boxes all use drag and drop. These dialog boxes let you select a file or a material and drag it on top of where you want to apply it. For example, with the Maps rollout in the Material Editor open, you can drag a texture image filename from Windows Explorer or the Asset Manager and drop it on the Map button. You can even drag and drop Max files from Windows Explorer into the Max interface to open them.

Controlling spinners

Spinners are those little controls throughout the interface with a value field and two small arrows to its right. As you would expect, clicking the up arrow increases the value and clicking the down arrow decreases the value. The amount of the increase or decrease depends on the setting in the General tab of the Preference Settings dialog box. Right-clicking on the spinner resets the value to its lowest acceptable value. Another way to control the spinner value is to click the arrows and drag with the mouse. Dragging up increases the value, and dragging down decreases it.

The effect of the spinner drag is shown in the viewport if the Update During Spinner Drag menu option is enabled in the Views menu. If the cursor is located within a spinner, you can press Ctrl+N to open the Numeric Expression Evaluator, which lets you set the value using an expression. For example, you can set a spinner value by adding numbers together as you would using a calculator. An expression of 30+40+35 sets the value to 105.
Chapter 33, “Animating with Constraints and Controllers,” covers the Numeric Expression Evaluator in more detail.

**Finding keyboard shortcuts**

Many features include keyboard shortcuts. These shortcuts can give you direct access to a command without moving the mouse. The default shortcuts for the menu commands are listed to the right of the command. You can use the Keyboard panel of the Customize User Interface dialog box to view and change the keyboard shortcut for any feature.

Appendix C, “Max Keyboard Shortcuts,” lists all the default keyboard shortcuts.

**Using strokes**

Strokes are similar to the keyboard shortcuts, except they allow you to draw a predefined shape using the middle mouse button as a shortcut to a command. For example, you can set up a stroke to undo the last action using a shape that looks like the letter U. Then you can undo the last action by clicking the middle button and dragging in the shape of the letter U. Strokes are convenient because they use the mouse, and you don’t need to reach for the keyboard. The Strokes feature requires a three-button mouse or a mouse with a scroll wheel.

Setting up and using strokes is covered in more detail in Chapter 5, “Customizing the Max Interface and Setting Preferences.”

**Understanding modeless and persistent dialog boxes**

Many dialog boxes in Max are modeless, which means that the dialog box doesn’t need to be closed before you can work with objects in the background viewports. The Material Editor is an example of a modeless dialog box. With the Material Editor open, you can create, select, and transform objects in the background. Other modeless dialog boxes include the Material/Map Browser, the Render Scene dialog box, the Video Post dialog box, the Transform Type-In dialog box, the Display and Selection Floaters, and the various graph editors. Pressing the Ctrl+~ keyboard shortcut closes all open dialog boxes. Pressing the same keyboard shortcut again reopens the dialog boxes that were previously closed.

Another feature of many, but not all, dialog boxes is persistence, which means that values added to a dialog box remain set when the dialog box is reopened. This feature applies only within a given Max session. Choosing the File→Reset command button or exiting and restarting Max resets all the dialog boxes.

**Getting Help**

If you get stuck, Max won’t leave you stranded. You can turn to several places in Max to get help. The Help menu is a valuable resource that provides access to references and tutorials. The New Features Guide, User Reference, and MAXScript Reference are comprehensive help systems that work like a Web browser. The Tutorial command loads the tutorials, which offer a chance to gain valuable experience.
The Hotkey Map displays an interactive interface for learning all the keyboard shortcuts. Additional Help presents help systems for any external plug-ins that are loaded. The 3ds max on the Web options (Online Support, Updates, Resources, and Partners) automatically open a Web browser and load the Discreet Support Web pages or look for updates.

The Authorize 3ds max command lets you enter an authorization number to authorize the software. The About 3ds max command opens the About dialog box. This dialog box displays the serial number and current display driver.

**Browser-based reference guides**

The New Features Guide, User Reference, MAXScript Reference, and Tutorials are Web browser-based help interfaces. An organized list of topics is available in the left navigation pane, as shown in Figure 1-11, and the right includes a pane where the details on the selected topic are displayed. Across the top are five toolbar buttons used to control the interface. The Hide button hides the left navigation pane, the Back and Forward buttons move between visited pages, the Print button prints the information in the right pane, and the Options button displays a pop-up menu of options.

![The User Reference](image)

**Figure 1-11:** The User Reference includes panels for viewing the index of commands and searching the reference.

Above the left navigation pane are five tabs that open separate panels when selected. The Contents panel displays a list of topics; the Index panel lists all topics alphabetically; the Search panel includes a text field where you can search for specific keywords; the Favorites panel keeps a list of bookmarks to topics you add to the list; and the Query panel lets you type a question and query for answers.

Throughout the textual descriptions, keywords linked to other related topics are highlighted in blue and underlined.
Online help

The Web offers many sites that can also help, and Max links to the Online Support, Updates, Resources, Partners and Training pages on the Discreet site from the Help➪3ds max on the Web menu. Selecting either of these menu commands automatically opens a Web browser and loads the Discreet Web pages.

Summary

You should now be familiar with the interface elements for Max. Understanding the interface is one of the keys to success in using 3ds Max. Max includes a variety of different interface elements. Among the menus, toolbars, and keyboard shortcuts, several ways to perform the same command exist. Discover the method that works best for you.

This chapter covered the following topics:

✦ The interface elements
✦ Viewing and using the pull-down menus
✦ Working with toolbars
✦ Accessing the Command Panel
✦ Learning the lower interface controls
✦ Interacting with the Max interface
✦ Getting additional help

In this chapter, we’ve skirted about the viewports covering all the other interface elements, but in the next chapter, we’re going to hit the viewports head-on.